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A Practical Guide to AutoCAD® Map 3D 2020 
 
Introduction 
Congratulations on choosing this course to help you learn how to use AutoCAD Map 3D 2020. The term 
“practical” is used in the title because this course focuses on what you need to effectively use AutoCAD Map 
3D 2020, and does not complicate your learning experience with unnecessary details of every feature in the 
product. Should you want to pursue aspects of features and functionality in greater detail than provided in this 
course, you are directed and guided to that information. 
 
Each lesson contains the concepts and principles of each feature to provide you with the background and 
foundation of knowledge that you need to complete the lesson. You then work through real world exercises to 
reinforce your understanding and provide you with practice on common tasks that other professionals are 
performing with AutoCAD Map 3D 2020 in the workplace every day. 
 
You can take the lessons in this course in whatever order is appropriate for your personal needs. If you want 
to concentrate on specific features, the lesson for those features does not require that you complete prior 
lessons. With this course organization, you can customize your own individual approach to learning AutoCAD 
Map 3D. 
 
When you complete this course, you will be armed with the background and knowledge to apply AutoCAD 
Map 3D to your job tasks, and become more effective and productive in your job. 
 
 
Course Objectives 
The objectives of this course are performance based. In other words, once you have completed the course, 
you will be able to perform each objective listed. If you are already familiar with AutoCAD Map 3D, you will be 
able to analyze your existing workflows, and make changes to improve your performance based on the tools 
and features that you learn and practice in this course. 
 
After completing this course, you will be able to: 
 

• Work with multiple coordinate systems 
• Clean drawings with common geometry errors 
• Work with COGO tools to accurately map objects 
• Insert rectified raster images 
• Work with a variety of attribute data 
• Apply object classification to your mapping system 
• Import GIS data from a variety of sources 
• Export geometry and attribute data to other GIS formats 
• Connect directly to GIS data and stylize features 
• Access Data using the Autodesk Connector for ArcGIS 
• Connect to raster surface data and raster images 
• Attach and query source drawings 
• Save changes to attached source drawings 
• Extract data for reports and quantity takeoffs 
• Create, manage and analyze topologies 
• Create dynamic scale bars, north arrows and legends 
• Produce map books to automate sheet layout 
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Prerequisites 
Before starting this course, you should have a basic working knowledge of AutoCAD®. A deep understanding 
of AutoCAD is not required, but you should be able to: 
 

• Pan and Zoom in the AutoCAD drawing screen. 
• Describe what layers are in AutoCAD, and change the current layer. 
• Create basic CAD geometry, such as lines, polylines and circles. 
• Use Object Snaps. 
• Describe what blocks are, and how to insert them. 
• Perform basic CAD editing functions such as Erase, Copy, and Move. 

 
If you are not familiar with these functions, you can refer to the AutoCAD Help system throughout the course 
to gain the fundamental skills needed to complete the exercises. 
 
 
Conventions 
The course uses the following icons and formatting to draw your attention to guidelines that increase your 
effectiveness in AutoCAD Map 3D, or provide deeper insight into a subject. 
 

 

 

 
 
  

  
The magnifying glass indicates that this text provides deeper insights into the 
subject. 

  
The compass indicates that this text provides guidance that is based on the 
experience of other users of AutoCAD Map 3D. This guidance is often in the form of 
how to perform a task more efficiently. 
 

  
The warning indicates that a specific exercise might not function properly on 64 bit 
operating systems. 
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Downloading and Installing the Datasets 
In order to perform the exercises in this book, you must download a zip file and install the datasets. 
 
Type the address below into your web browser to load the page where you can download the dataset. 
www.cadapult-software.com/data 
 
Unzip the Files 
Unzip the file APG_Map2020.zip directly to the C drive. The zip file will create the following folder structure: 
 
C:\A Practical Guide\Map 3D 2020\Chapter Number\Files for Exercises 
 

 
 
 
Exercises 
The exercises in this course have been carefully chosen and designed to represent common tasks that are 
performed by mapping and GIS professionals. The data included in the exercises are typical drawings and 
maps used by local governments and municipalities. You work with road networks, parcel maps, sewer 
collection systems, water distribution systems, aerial photos, raster surfaces, and much more. 
 
Exercises provide higher level process information throughout the exercise tasks. You are given information 
about not only what to do, but why you are doing it. In most cases, an image is included to help guide you. 
 
 
64 Bit Database Drivers 
On 64 bit systems, exercises that require a connection to an ODBC database need to have the proper drivers 
from Microsoft installed.  If your system does not have these installed, you can download them from Microsoft.  
Go to [ http://www.microsoft.com ] and search for Microsoft Access Database Engine. 
 
Be sure to download the 64 bit version of the Microsoft Access Database Engine.  You do not need to have 
Microsoft Office installed to install these drivers or to complete the exercise in this book.  However, if you 
have Microsoft Office installed it will need to be the 64 bit version of Office for the 64 bit drivers to install. 
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5.1 Lesson: Importing GIS Formats 

 
Introduction 
Importing GIS file formats into AutoCAD® Map 3D opens the door to a tremendous amount of 
data. Much of this data is free, and can be integrated into your mapping system. In this 
lesson, you begin by learning the formats and types of data that can be imported into 
AutoCAD Map 3D, and guidelines around integrating other mapping data into your mapping 
system. You then import an ArcView SHP file into AutoCAD Map 3D. 

 
 

 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
Key Concepts 
Concepts and key terms covered in this lesson are: 

• Import 
o Geometry 
o Attributes 
o Coordinate Systems 

• Import dialog box 
 
 
Objectives 
After completing this lesson, you will be able to: 

• Describe what map Import is. 
• List the components that can be imported, and how AutoCAD Map 3D interprets incoming data. 
• Identify and explain the tools used to import GIS data. 
• Import street segments with Object Data. 
• Import zoning polygons with an external data source. 
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About Importing GIS Data into AutoCAD Map 3D 
GIS Data generally contains three types of data: geometry, attributes, and coordinate system 
data. Using the map import tools, you can define how AutoCAD Map 3D interprets and 
imports all three types of data. 

The Map Import commands are used to convert other GIS formats into AutoCAD Map 3D 
geometry and attributes with the intent to retain them in the AutoCAD Map 3D format, with no 
need to maintain them in  their original GIS format.  

 

 
 

Geometry 
All GIS formats are different. AutoCAD Map 3D imports the data in such a way as to 
represent the native format as closely as possible. An example of this functionality is when 
importing line data from an ArcView shape file, any segments in the incoming file that have 
vertexes are imported as polylines, while those that are simple lines with a start and endpoint 
are imported as lines. 

Points can be imported and mapped to either AutoCAD points, or blocks that are defined in 
the drawing. 

Attributes 
Attributes that are associated with incoming data can be mapped to Object Data, or can be 
imported to an attached data source, such as a Microsoft Access database table, and linked 
to the objects at the same time. 

Coordinate Systems 
If the incoming file has coordinate system information associated with it, either within the file 
itself, or a companion file, AutoCAD Map 3D will read this information and convert the 
coordinates to the target drawing file. If there is no coordinate system information in the 
incoming file, you can assign a coordinate system to it during the import procedure. 

Spatial Filters 
Some GIS applications can manage larger data sets than can be reasonably managed within 
AutoCAD Map 3D. Spatial filters enable you to limit the amount of data that you import based 
on a location in the current map.  

  

AutoCAD Map 3D can also connect to data as a feature source and work with these 
files in their native format. This functionality is covered in another lesson. 
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Guidelines for Preparing for Map Import 
You can start a new drawing and simply import data. In most cases, you want to prepare a 
target drawing with layers, Object Data tables, or attached data sources that will receive the 
incoming data. This is especially true if your office has mapping standards that must be 
adhered to, or if you are importing into an existing drawing that already has all the layers, 
Object Data tables, or attached data sources present. 

Another important point when preparing for an import is to have some familiarity with the 
incoming data. This may come from metadata or documentation of some kind. The best way 
to qualify the incoming data is to use the native application to review. However, this is not 
always possible, in which case the import process might be a trial and error process until you 
can make the correct settings for the final import. 

 
 

The Import Interface 
Once the target file is prepared, and the incoming data is qualified, the entire import 
procedure is performed in a single interface with various dialog boxes for the settings. 

 

 

  
If you perform the same type of import regularly, you can save a profile of the 
settings and load the profile each time you perform an import. You can also create a 
drawing template that has all of the definitions such as Object Data tables, layers, 
blocks and so on. 
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Exercises: Import Data from Other GIS Formats 
In these exercises you will import street centerlines that were sent to you as an E00 file.  An 
ArcInfo coverage may either be stored as a directory of related files, or exported into a single 
E00 export file from ArcInfo or ArcGIS, as in this exercise. 

Then you will, import parcel polygons from an ArcView Shapefile and convert their coordinate 
system. 

Finally, you will create centroids and move the attached data from each polyline to the 
corresponding centroid.  This is the first step in the process of cleaning the geometry, an 
important process whenever base map data is imported. 

The use of the import command is very similar for all the different types of supported GIS 
data file formats.  However, there are some differences depending on the type of geometry 
that is contained in those files (points, lines, or polygons).    

 

You do the following: 

• Import streets from an E00 file. 
• Import parcels from an ArcView shape file and convert its coordinate system. 
• Create centroids for the parcel polygons. 

 

 

5.1.1 Importing an ArcInfo Coverage 

In this exercise you will import street centerlines that were sent to you as an E00 file.  An 
ArcInfo coverage may either be stored as a directory of related files, or exported into a single 
E00 export file from ArcInfo or ArcGIS, as in this exercise. 

1. Press Ctrl + N and select the default template map2d.dwt to start a new, blank drawing. 

2. Select Ribbon: Insert ⇒ Import ⇒ Map Import. 
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The Import Location dialog box opens. 

  

3. Set the file type to Esri ArcInfo Export (E00). 

4. Browse to the Chapter 05 folder and select streets.e00. 

In the Import dialog box you can configure the Layer, Coordinate Conversion, and Data 
options that you wish to use to import the information into AutoCAD.   

 

5. Ensure that the STREETS_arc Input Layer is selected. 

6. Click on the Drawing Layer field in the STREETS_arc row, to activate the More button <<…>>. 

7. Click the More button <<…>> to launch the Layer Mapping dialog box. 
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Here you can choose to import the drawing objects onto an existing layer, create a new layer, 
or select a column of data from the file that you are importing to determine the layer names.  
This last option will allow you to do some basic thematic mapping during the import of the 
objects.  For example, if you were importing parcel data and that data set had a column for 
zoning.  You could have the import command create a new layer for each zoning type and 
place each parcel on the appropriate layer for its zoning designation. (See Additional 
Exercises at the end of this chapter for more information).   

In this exercise, you will place all of the streets on one new layer. 

8. Choose the Create on new layer option to activate the text 
box. 

9. Enter "Streets" for the layer name. 

10. Click <<OK>> to return to the Import dialog box. 

 

 

11. Click on the Data field in the STREETS_arc row to activate the More button <<…>>. 

12. Click the More button <<…>> to launch the Attribute Data dialog box. 
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Here you specify what attribute data to import and where to store it.  You can enter the 
desired name for the Object Data Table and select the desired fields to import.  This is the 
step that allows you to bring the intelligence of the GIS file along with the geometry into 
AutoCAD.  By creating the object data table and populating it with the information provided in 
the coverage you will be able to click on a street and find the street name, type, speed limit, 
and any other information that was added by the GIS department.  This will also allow you to 
edit the geometry and data from the GIS file in AutoCAD and then export it back to any of the 
supported GIS formats without losing any of the attached data.  If you leave the Data option 
set to None or Do not import attribute data, then you will only import the geometry of the file 
and you will lose all of the attached information. 

13. Choose the Create object data option to activate the 
Object Data section. 

14. Change the Object Data table name to "Streets". 

15. Click <<Select Fields>>. 

 

Here you specify which fields to import into the Object Data table. 

16. Deselect all Input Fields except NAME_FULL, TYPE, 
SPEED, OWNER, PAVED, and FCLASS. 

You only need to import the fields that you want to have available.  
So if there is extraneous data that you don't need, you can skip it 
and keep the file size smaller.   

It is also important to understand that many GIS programs store 
geometric data, like length and area, in data tables, while in 
AutoCAD the geometry is a physical property of the object.  In this 
example, if you were to import the length field, it would be a static 
value in the object data table and would not update if the length of 
the line is altered. 

17. Click <<OK>> to dismiss the Object Data Mapping 
dialog box. 

18. Click <<OK>> to dismiss the Attribute Data dialog box. 
 

19. Click <<OK>> in the Import dialog box to import the file. 

The streets are imported into the drawing as polylines, with the GIS data attached as Object 
Data. 

20. Once the 287 objects are imported, zoom to Extents. 
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21. Select Ribbon: Tools ⇒ Map Edit ⇒ Edit Object Data. 

 

22. Pick a line segment anywhere in the drawing. 

 

Here, you can view the object data associated with the line segment you picked. You can also change the 
value of any field in this object’s data, or even add a record to a new or existing object.  It is also possible to 
view and edit object data using the AutoCAD Properties command. 

23. View the object data associated with a few other line segments.  

24. Click <<Cancel>> once you are through viewing the fields, to avoid saving any inadvertent 
changes. 

25. Save the drawing as “Streets” in the Chapter 05 folder 
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5.1.2 Importing Polygons from an ArcView Shapefile 

In this exercise you import parcel polygons from an ArcView Shapefile.  This Shapefile 
geometry resides in a different coordinate system, and will be converted during the import 
process. 

1. Open City Taxlots OD.dwg from the Chapter 05 folder. 

This drawing contains the city taxlots file that you worked with in previous chapters, with the 
Taxlot attribute data as object data. 

The county taxlots you are about to import are in a different coordinate system, which Map 
3D will convert during the import process.  The first step is to assign the correct coordinate 
system to the base map. 

2. Select Ribbon: Map Setup ⇒ Coord System ⇒ Assign. 

 

3. Click <<Select Coordinate System>> in the Current Drawing section, to open the Coordinate 
System - Assign dialog box. 

 

4. From the Category list, select USA, Oregon. 
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5. From the list, select OR-S NAD27 Oregon State Planes (Polyconic), South Zone, US Foot. 

Notice the column of codes on the left, and that the code for the selected coordinate system 
is OR-S.  

Once you become familiar with commonly used coordinate systems in your region, 
you can learn the short codes and simply enter them in the Coordinate System - 
Assign dialog box. 

6. Click <<Assign>> to assign the Global Coordinate System. 

The drawing is now identified with the NAD 27 State Plane coordinate system - no conversion 
has occurred, you have a simply assigned that coordinate system to this base map.  Next, 
you will import the county GIS data, which is in a different coordinate system,  and AutoCAD 
Map 3D will convert it to this coordinate system. 

Notice that the code for this coordinate system, OR-S now appears on the Status Bar: 

 

7. Select Ribbon: Insert ⇒ Import ⇒ Map Import. 

 

The Import Location dialog box opens. 

 

8. Set the file type to ESRI Shapefile (*.shp). 

9. Navigate to the Chapter 05 folder and select TL_C_83. 

10. Click <<OK>> to launch the Import dialog box. 
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Here you specify all import parameters. 

 

11. Click on the Drawing Layer field in the TL_C_83 row to activate the More button <<…>>. 

12. Click the More button <<…>> to open the Layer Mapping dialog box. 

  

13. Choose the Create on new layer option to activate the text field. 

14. Enter Taxlot_County for the new layer name. 

15. Click <<OK>> to return to the Import dialog box. 

Notice that the Current drawing coordinate system (the base map into which you are now 
importing this ESRI Shapefile) is in NAD27, which you set at the beginning of this exercise.   

Also notice that the Input Coordinate System is showing OR83-SF, which is the code for 
NAD83 Oregon State Planes (Polyconic), South Zone, US Foot. 
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Map 3D is getting this information from the .PRJ file, that accompanies the .SHP file. This file 
contains the coordinate system information.  When you acquire Shapefiles from others, 
always ask for coordinate system information. If there is not an accompanying .PRJ file, but 
the coordinate system is known, you could use the More button <<…>> in the Input 
Coordinates field to select it manually, using the Coordinate System Library. 

 

16. Click on the Data field to activate the More button <<…>>. 

17. Click the More button <<…>> to open the Attribute Data dialog box. 

18. Choose the Create object data option to activate the 
External Database section. 

19. Select Parcels from the Object data table list.  

The object data table exists in the City Taxlots OD drawing.   

AutoCAD Map 3D will add the new records to the existing object 
data table during the import process. 

20. Click <<OK>> to return to the Import dialog box. 
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21. Enable the Import polygons as closed polylines option. 

This will create each taxlot as a closed polyline, as opposed to a polygon object. 

22. Click <<OK>> to import the file. 

AutoCAD Map 3D will process 396 objects and import them into the current drawing, and 
append 396 corresponding records to the attached database.  

23. Zoom to Extents. Your drawing should look like this: 

 

The county parcels have been imported and converted to the coordinate system of the city taxlots drawing. 

24. Save the drawing as Regional Taxlots.dwg in the Chapter 05 folder. 
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5.1.3 Creating Centroids 

In this exercise you will first create centroids and move the attached data from each polyline 
to the corresponding centroid.  This is the first step in the process of cleaning the geometry, 
an important process whenever base map data is imported. 

1. Continue working in the Regional Taxlots.dwg that you created in the last exercise. 

2. Freeze the Taxlots and Centroid layers to isolate the Taxlot_County layer. 

3. Select Ribbon: Create ⇒ 
Drawing Objects ⇒ Create 
Centroids. 

 

The Create Centroids dialog box opens. 

 

4. In the Create Centroids in section, choose Selected only: 

5. Click the select objects button  

This temporarily closes the dialog box so you can pick the objects. 

6. Pick all the polygons with a crossing window and press Enter. 



 Chapter:  Importing and Exporting 

174 Lesson: Importing GIS Formats 

 

7. Click the New Layer button  to make the layer Centroid_County on which to create the 
centroids. 

8. Confirm that ACAD_POINT is selected in the Create using field. 

9. Click <<OK>> to create a centroid for each closed polygon. 

This creates a point at the geometric center of each polygon and moves the data from the 
polyline to the new centroid.   

10. Pick one of the new centroids, then right-click and select ⇒ Properties. 

11. In the Properties palette, scroll to the 
bottom and notice the attribute data from 
the SHP file is now attached to the tax lot 
centroids. 

 

12. Save the Drawing. 

 
Lesson Review 
In these exercises you imported street centerlines that were sent to you as an E00 file.  An 
ArcInfo coverage may either be stored as a directory of related files, or exported into a single 
E00 export file from ArcInfo or ArcGIS, as in this exercise. 

Then you imported parcel polygons from an ArcView Shapefile and converted their 
coordinate system. 

Finally, you created centroids and moved the attached data from each polyline to the 
corresponding centroid.  This is the first step in the process of cleaning the geometry, an 
important process whenever base map data is imported. 
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7.3 Lesson: Connecting to Raster and Raster Surfaces 

 
Introduction 
Connecting to raster data as a feature source is similar to inserting images using AutoCAD® 
Map 3D Image Insert. In each case, the file is only referenced and not part of the drawing 
itself. In this lesson, you learn the differences between these two methods and the advantage 
of using the feature source connection. You also learn some of the tools that are used to 
connect to a raster image, and then connect to a raster image. 

Connecting to raster surfaces is similar to connecting to raster images. The main difference is 
that raster surfaces contain elevation data associated with each pixel. AutoCAD Map 3D uses 
this method for simple surface analysis and visualization as part of the feature source. In this 
lesson, you learn the basic concepts of raster surfaces, the types of files that you can access, 
and how raster surfaces can be used as part of your mapping system. You then connect to a 
digital elevation model, and add it to your map. 

 

 
 
 
Key Concepts 
Concepts and key terms covered in this lesson are: 

• Raster feature sources 
• Raster surfaces 
• Viewing raster surfaces in 3D 
• Draping raster and vectors over surfaces 

 

Objectives 
After completing this lesson, you will be able to: 

• Describe what a raster feature source is. 
• List the types of raster formats that can be accessed. 
• Explain how raster surfaces can be used. 
• Connect to an ortho photo. 
• Connect to a raster surface. 
• Drape vectors and raster over a raster surface. 
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Raster Feature Source Concepts 
You can use raster data in AutoCAD Map 3D through the Map Image Insert command and by 
connecting to raster as a feature source. There are some very powerful reasons to use a 
feature source connection rather than inserting raster: 

• Performance 
• File formats 
• Coordinate conversion 

 
Performance 
The performance of raster as a feature source is much better than that of raster inserted in a 
drawing. In some cases this performance enables access to raster that otherwise cannot be 
used because of file size. 

 
File Formats  
Connecting to raster as a feature source opens a larger selection of geospatial-based file 
formats to work with. In addition to the formats that are offered directly in standard AutoCAD 
Map 3D, the fact that the feature data objects (FDO) technology is open source enables 
developers to write additional FDO providers to access even more file formats. 

 
The following illustration shows the file formats available in the Map Image Insert command. 
While it offers a wide variety of file formats to select from, when considering the geospatial 
specific formats, it is fairly limited. 
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The following illustration shows the file formats available when connecting to raster as a 
feature source. The formats available through this method are especially useful for geospatial 
applications. 

 

 
 
 
Coordinate Conversion 
Connecting to raster as a feature source enables the coordinates of the raster to be 
converted to the coordinates of the current drawing. This is a very important distinction 
between connecting and inserting raster. When using Map raster insert, whatever the 
coordinates of the raster are determines the coordinates of your map. This is very limiting 
when compared to the coordinate conversion available using a raster feature source 
connection. 

Raster Surface Concepts 
When working with raster as feature sources, the process and procedures to connect and 
add both standard raster and raster surfaces are the same.  

 

Both types of raster are composed of pixels. In the case of raster surfaces, each pixel has a Z 
value rather than a value such as grey scale or color that produces a “picture”. AutoCAD Map 
3D can interpret the Z values in a raster surface, and produce three dimensional views and 
analysis. 
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Raster Feature Layers 
When a raster is connected to, and added to a map, the management of the feature layer is 
the same as that of vector based feature layers.  

 

 
 
 
Working with Raster Surfaces 
There are several tools available to take advantage of the elevation data that is inherent in a 
raster surface. These tools include creating contours, slope, aspect, and elevation analysis, 
draping, and assigning exaggeration values to the elevations. In this lesson, you work with 
draping and exaggeration.  

 
Draping 
Draping refers to vector and raster objects which adopt the three dimensional characteristics 
of the underlying surface. By default, when a raster surface feature layer is present in a 
drawing, all other feature layers, both vector and raster drape over the raster surface 
depending on the draw order of the feature layers. 

 

 
 
 

 
 
  

  
AutoCAD objects do not drape over raster surfaces. 
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Exaggeration 
Exaggeration can be applied to raster surfaces to create a more impactful representation of 
the terrain when needed.  

In the following illustrations, the image on the left is a raster viewed in 3D with no 
exaggeration. The image on the right is the same raster surface with an exaggeration value 
of 3x. 

 

 
 

 
 
Exercises: Connecting to Raster and Raster Surfaces 
In these exercises, you start in a drawing that has a parcel feature layer connected. You 
connect to a raster image of an ortho photo of the area of interest. You then connect to a 
raster surface, change the draw order, and view the map in 3D. 

 

You do the following: 

• Connect to a raster image and add it to the map. 
• Change the draw order to view the parcels on top of the raster. 
• Connect to and add a raster surface to the map. 
• Set the draw order to drape the parcels and ortho photo over the surface. 

  
Exaggeration should be used sparingly. It often dramatically misrepresents the map. 
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7.3.1 Connecting to an Aerial Photo 

1. Open the drawing Connect to Raster.dwg from the Chapter 07 folder. 

In the first series of steps, you connect to the raster image and add it to the map. 

2. In the Display Manager, confirm that the Groups button 
is selected. 

3. In the Display Manager, click the Data button, and then 
select ⇒ Connect to Data… . 

 

 

The Data Connect palette opens.  Here you can select from many different data providers or 
sources.  In this exercise you will be connecting to a raster image file.   

 

  

4. From the Data Connections by Provider list, select Add Raster Image or Surface Connection. 

5. Change the Connection name: to Ortho. 

6. Click the file button  and browse to the Chapter 07 folder, and select Aerial.tif. 
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7. Click <<Connect>>. 

  

8. Click <<Add to Map>>. 

9. Close the Data Connect palette. 

Notice the feature layer Aerial now appears in the Display Manager. A layer in the Display 
Manager is different than an AutoCAD layer; it is the name of a data source and where you 
manage its properties.  

Notice the aerial photo is on top of the parcels. 

10. In the Display Manager, select the Draw Order button. 

The list of feature layers is displayed in the current draw order. The order these are listed in 
matches the feature layers in the drawing. 

11. Drag the Parcels feature layer above the Aerial layer. 

12. Zoom into the map to view the image with the parcels overlaid. 

13. Save the drawing for use in the next exercise. 
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7.3.2 Connecting to a Raster Surface 

In this exercise you connect to and add to the map an elevation enabled raster, or raster 
surface. Once the surface raster is added to the map, you change the draw order, and view 
the map in 3D. Any feature layer that is on top of the surface will automatically drapes over 
the surface. 

1. Continue working in Connect to Raster.dwg from the previous exercise. 

If you did not complete the previous exercise you can open the drawing Connect to 
Surface.dwg. 

2. Connect to a Raster Surface.  Repeat Steps 3-9  from the previous exercise using the following 
information: 

o For the Connection Name enter Elevation 
o Connect to the file Existing Ground.dem in the Chapter 07 folder 

 
3. In the Display Manager, select Draw Order. 

The list of feature layers is displayed in the current draw order. The order these are listed in 
matches the feature layers in the drawing. 

4. Drag the feature layers to match the following order: 

o Parcels 
o Aerial 
o Existing Ground 

 

5. In the Status bar, select 3D Mode. 

The map is displayed in 3D. 

 

6. In the Status bar, for Vertical Exaggeration, 
select 2x. 

Note: It might take a few moments to optimize the layer. 
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7. Zoom into the map to view how the 
raster and parcels are draped over 
the surface raster. 

8. Experiment with various Vertical 
Exaggeration values and 3D 
viewing angles. 

NOTE: Be careful when applying 
Vertical Exaggeration, and use it 
sparingly. While it can help visualize 

terrain in relatively flat areas, it can dramatically 
misrepresent actual conditions.  

 

Lesson Review 
In these exercises you integrated three different sources of data. Vector based parcels, an 
ortho photo, and a surface. Together, these sources of data were combined to view how the 
parcels and the image drape over the existing ground terrain. 



 

  449 

 

Index 
 

2D Drafting 7 
3D Navigation 259 
Add Data to a Map 194, 201 
Adding New Features 294 
Altering Properties 368 
Anchors 36 
Angle Data 26 
Annotation Blocks 116 
Annotation Template 116 
ArcGIS Online 201 
Attach Object Data 59, 66, 69 
Attribute Data 52, 53 
AutoCAD Image Insert 225 
AutoCAD Map 3D Image Insert 226 
AutoCAD Options 8 
AutoCommit 90 
Autodesk Connector for ArcGIS 201 
Automatic Check In 292 
Automatic Checkout 292 
AutoSave 8 
Best Route 411 
Bitonal 223 
Block Attributes 55 
Bulk Copy 320 
Cancelling Checkout 293 
Centroid 400 
Check-In/Checkout 292 
Classifying Existing Objects 150 
Clustered Nodes 35, 394 
COGO Inquiry 26 
Command Line 8 
Compound Queries 346 
Connecting to ODBC 213 
Connecting to Raster 240 
Constraints 312 
Contextual Ribbons 4 
Contours 262 
Convert Coordinate Systems 385 
Coordinate Conversion 238 
Coordinate Geometry 25 
Coordinate System 17, 161, 192, 215, 383 
Coordinate System Grid 436 
Coordinate Tracker 18 
Correlation Files 224 
Create Scale Ranges 270 
Creating New Classified Objects 155 
Creating New Features 293 
Crossing Objects 35, 394 
Current Drawings 331 
Data Panel 379 
Data Queries 360 

Data Source 85 
Data Source Name 215 
Data Table 208 
Data Table Tools 209 
Data View 89 
Datums 15 
Define Object Data 59 
Digital Elevation Model 236, 258 
Display Manager 5 
Drafting Settings 8 
Draping 239, 261 
Draw Order 210, 230 
Drawing Cleanup 393 
Drawing Locks 335 
Drive Aliases 332 
Duplicate Objects 35 
Dynamic Annotation 114 
Edit Feature Attributes 291 
Edit Feature Geometry 291 
Edit Object Data 59, 75, 76, 78 
Editing Attributes 293 
Editing Existing Features 294 
Editing Object Data Tables 79 
Editing Transaction Model 375 
Error Markers 403 
Esri account 201 
Export File Types 176 
Export Process 178 
Exporting 175 
Expression Builder 285, 286 
External Data Sources 53 
External Databases 84 
Feature Class 192 
Feature Filters 284 
Feature Joins 301 
Feature Layer 193, 207 
Feature Layer Selectivity 210 
Feature Queries 284 
Feature Source 186, 189 
Feature Source Connect 190, 200, 226 
Feature Styles 246 
Feature Thematic Maps 274 
Filter to Select 287 
Flood Trace 411 
Generating Links 86, 98, 99, 101 
Global Coordinate Systems 15 
Grey Scale 224 
Hillshading 260 
Image Behavior 230 
Image Correlation 226 
Image Frames 230 



 

450  

Import Attributes 161 
Import Coordinate Systems 161 
Import Geometry 161 
Import Interface 162 
Import Spatial Filters 161 
Inserting Dynamic Annotation 121 
Joins 300 
Layout Elements 425 
Legend 425 
Line Feature Styles 250 
Link Template 85, 98, 99, 100 
Linking External Databases 85 
Links 391, 400 
Location Queries 341, 344 
Maintenance 7 
Manually Link 101 
Map Book Dialog 441 
Map Book Template 439 
Map Books 423, 424 
Map Classic 7 
Map Explorer 5, 314 
Network Analysis 410 
Network Topologies 390 
Nodes 391, 400 
North Arrow 426 
Object Class Objects 156 
Object Classes 151 
Object Classification 138, 139, 155 
Object Classification Definition File 140 
Object Data 54, 57, 67, 162, 361 
Objects 187 
ODBC (Open Data Base Connectivity) 213, 214 
Online Map 234 
Planning and Analysis 7 
Point Feature Styles 249 
Polygon Feature Styles 250 
Polygon Overlay 412 
Polygon Topologies 399 
Projection 15 
Properties Palette 76 
Property Alteration 370 
Property Queries 341, 345 
Pseudo Nodes 35 
Quick View 333 
Ranges and Styles 268 
Raster 222, 223, 236 

Raster Feature Layers 239 
Raster Feature Source 237 
Raster Metadata 225 
Raster Surface 236, 238 
Raster Surface Styles 259 
Raster Surface Themes 261 
Reference Grid 427 
Reference Management 230 
Reference System 427 
Refresh Annotation 117 
Relational Data Base Management Systems 189 
Ribbon 3, 208 
Save-Back 374 
Save-Back Options 377 
Saved Queries 347 
Scale Bar 426 
Scale Dependent Styles 266 
Scale Ranges 248 
Schema 321 
Schema Editor 314 
Shortest Path 410 
Source Drawings 330 
SQL Queries 362 
Style Editor 246 
Style Editor Palette 248 
Style Scale Ranges 246 
Styles 248 
Stylize Raster Surfaces 258 
Stylizing features 246 
Surface Exaggeration 240, 259 
Task Pane 4, 209, 334 
Theme Feature Labels 276 
Theme Legend Labels 276 
Theme Ramps 276 
Themes 273, 369 
Tolerance 36 
Topology Analysis 409 
Topology Object Data 392 
UDL file 85 
Update Annotation 117 
User Interface 1 
Validating Standards 149, 312, 315, 369 
Vector Objects 223 
Viewing Linked Data 102 
Workspaces 7 

 

 

 


